
FAQ
Get answers to your questions quickly with our FAQ section. Explore common queries and find
solutions effortlessly, ensuring a smooth experience with Smart Engage.
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How Do I Add The Tracking Code to my website?
How Do I Add TXT Records for SPF and DKIM?
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Why Web Push Notification Delivery Rate Might Be Lower Than Expected
How to Unarchive a tag
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What is Considered a
Subscriber?
Here at SmartEngage, we believe that a subscriber is a person.  That person may have multiple
methods in which you use to contact him/her, but it is still just a single subscriber.

This means that if you have an email address for a subscriber as well as their Facebook Messenger
and Push Notification contact details - we will still only count this as 1 Single Subscriber. 

We also do not double count subscribers across different Brand Avatar accounts.  This means that
if you have Dave as a subscriber on your Brand Avatar page for Yoga Fitness and Dave also
appears as a subscriber on your Brand Avatar page for Anti-Aging skin cream - He is still only
considered 1 subscriber for your account.
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4 Platforms = 1 Person = 1 Subscriber

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/xUKimage.png


How Are Your Inbox Rates So
Great!?
Thanks for noticing :)

We know that email marketing isn't easy and that's why we sought the experts when building
SmartEngage. We have partnered with the industries top emal marketing professionals in order to
provide the highest inbox rates possible. 

We take a multi faceted approach to maintaining our extremely high inbox rates.

Step 1: We first require customers of SmartEngage to add TXT records for DKIM/SPF records. 
Without getting too fancy, this is just a simple way to maximize your trust and deliverablity.

Step 2: Next we use an automatic list hygiene algorithm. Some cleaning services focus only on
determining whether the emails on your list are valid or invalid, some focus only on catching
spamtraps and other bad threats. SmartEngage focuses on everything: invalids, spamtraps, bots,
role accounts and much more including dormant accounts - the ultimate key to deliverability at the
biggest email receivers. Here are the main points we focus on:

A. Find and Remove Dormant Accounts - Dormant accounts are email addresses at the top mailbox
providers that USED TO BE GOOD but were then abandoned by their owner (probably because of
receiving too much email). These mailbox providers (like Gmail, Yahoo, AOL and Microsoft) then
REACTIVATE those old, dormant accounts with the express purpose of catching email marketers
who have not removed them from their lists after being warned for 6 months to do so. (Sneaky,
sneaky.) Sending marketing emails to dormant accounts is probably one of the WORST things you
can do for delivery

B. Find and Remove Spam Traps - Spam Traps are email addresses created for the purpose of
catching people who send unsolicited emails. They NEVER optin to receive emails and they are
almost always added through using 3rd party rented or purchased lists. Mailing Spam Traps
immediately indicates that you are using 3rd party lists and pretty much destroys your
deliverability. 

C. Find and Remove Invalid Emails - Invalid emails are emails that do not exist. They are made up,
inserted in your lists by malicious users and freebie seekers and they cannot be delivered to. They
will do serious damage to your reputation as a respected email marketer.



D. Find and Remove Typo Domains - Typo domains are emails with mistakes in the spelling of the
domain. Examples include gmil.com and hotmial.com. Mailing them indicates you care very little
about your sender reputation and as such, you will have a lower reputation.

E. Find and Remove Serial Complainers - Serial Complainers are like Serial Killers - they keep doing
the same bad thing over and over again. They are well known for only complaining about the
commercial email they receive. 

F. Find and Remobe Bots - Bots are robots that are added to your list simply to waste your time.
They artificially inflate your Click #s and provide you no value. They upset advertisers and list
partners, drive down your PPC & ECPM and will NEVER become a lead or buyer. They are just taking
up valuable space that could be filled with high quality prospects. Draw out this poison from your
lists immediately!



What is the 24 Hour
Facebook Messenger Rule?
The first thing to understand are the types of Facebook Messenger Broadcasts you are able to
send.

There are three different types of broadcasts you can send on Facebook Messenger, and each type
has its own rules and guidelines.

Why did Facebook create these rules?

They want to ensure their users have a great experience when using Messenger. This means
avoiding spam content.

So yes, you are limited in how often you can send promotional emails via Facebook Messenger. but
keep in mind the benefit of all those rules: when you do send a promotion to your subscribers, they
will be more receptive because they aren’t being inundated with junk messages.

Here’s a quick overview of the three types of broadcasts along with the rules for each one.

1. Subscription Broadcasts - This is known on SmartEngage as our Subscription Interest
message. This is your typical non-promotional message Subscription broadcasts cannot contain
promotions or ads, but on the other hand, you can send them anytime you want—regardless of
your subscribers’ activity level.

Subscription broadcasts are best used to ask your subscribers questions. If they interact in any way
such as replying or clicking a button; they will then be considered within the 24 hour window to
now receive a promotional message.

 

2. Promotional Broadcasts - This type of broadcast will allow you to send ads and/or
links. However, you can only send promotional broadcasts to subscribers who have interacted with
you on Facebook Messenger in the past 24-hours. This is the importance of the Subscription
Interest message discussed above.

3. Follow-Up Broadcasts - This is handled automatically by SmartEngage and essentially acts
just like a Promotional Message. The way this works is once you send someone a Promotional
Broadcast, they have up to 24 hours to interact with your bot.  If they do not interact with your bot



you will be allowed one more last chance to send them a promotional message. If they do not
interact within 24 hours of this message then they are now only allowed to be contacted via our
Subscription Interest method. BUT, should they ever interact with your Subscription Interest
message, then the 24 hour clock resets and they can be contacted via a Promotional message once
again.



What browsers do Push
Notifications support?
SmartEngage integrates with major browsers which allow this type of technology to be used.

SmartEngage supports the following:

1. Google Chrome (version 42+) on Windows, Mac OS X, Linux and Android 
2. Firefox (version 44+ for desktop 48+ for mobile) on Windows, Mac OS X, Linux and

Android
3. Opera (version 42+ for desktop and 37+ for mobile) on Windows, Mac OS X, Linux and

Android



What is Mobile Mailer?
Mobile Mailer is a special feature we added which is responsible for obtaining extremely high open
rates because it always retrieves the user's primary email and real name.

Statistics show that up to a third of all manually entered Opt in forms result in a fake or secondary
email address being used. It is typically a throw away email address that is almost never checked
other than receiving confirmations. 

For More information visit:  https://smartengage.com/knowledge-base/books/lead-
magnet/page/using-mobile-mailer-feature 

https://smartengage.com/knowledge-base/books/lead-magnet/page/using-mobile-mailer-feature
https://smartengage.com/knowledge-base/books/lead-magnet/page/using-mobile-mailer-feature


What is a Brand Avatar?
Your Brand Avatar is Your Business! A person can also be a brand. The important thing here is
that you have a Facebook Fan Page for your Brand which will be used to help keep things
organized inside of SmartEngage.

Image not found or type unknown

Your Brand Avatar essentially performs as its own entity. Each one has a unique tracking code as
well as its own integrations which must be configured.  

Using Brand Avatars gives you the ultimate control to configure each business you own and
operate with its own custom settings.

Lets say you are a Yoga Instructor and you have a Facebook page for your Yoga business.  That
would be considered 1 Brand Avatar.  Lets also assume that you have a side business that sells
health supplements. This would also be considered a separate business so you would want to have
another Brand Avatar created for this as well.

Each Brand Avatar has its own list of subscribers to keep things nice and organized. And what's
even better is if you have the same subscriber appear on multiple Brand Avatars within
your account; We only count that as one subscriber so you get the most bang for your
buck.



Where can I Find My Brand
Avatar's Tracking Code?
SmartEngage uses a universal tracking code that is responsible for displaying Lead Magnets,
Tracking Users, and Conversion Tracking.

You will be prompted to copy your tracking code during the Brand Avatar creation process, but if
you ever need to find this tracking code again simply follow these steps.

Step 1: From your logged in Dashboard page click on your current Brand Avatar and then directly
underneath it click on "Manage/Integrate".
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Step 2: On the left side navigation menu click on "Tracking Code"
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Step 3: You will then see text box with your tracking code script displayed. You can simply click
the link "Copy to Clipboard" in order to copy the code.
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The instructions for Adding Your Tracking Code can be found here:
https://smartengage.com/knowledge-base/books/faq/page/how-do-i-add-the-tracking-code-to-my-
website 
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https://smartengage.com/knowledge-base/books/faq/page/how-do-i-add-the-tracking-code-to-my-website
https://smartengage.com/knowledge-base/books/faq/page/how-do-i-add-the-tracking-code-to-my-website


How Do I Add The Tracking
Code to my website?
If you would first like to find your tracking code please read this article:
https://smartengage.com/knowledge-base/books/faq/page/where-can-i-find-my-brand-avatars-
tracking-code 

Now that you have your tracking code we need to add it to your website. It should be added to the
Header of every page of your site that you plan to track or display lead magnets on.

Note: You only have one tracking code for each Brand Avatar and SmartEngage will work best if
this is on every page of your website.

Paste Tracking Code Into Website
Header
✔️ Paste the code between the  <head>  and  </head>  tags of your website. 
✔️ Make sure it's on every page of your site that you plan to track, capture or display on (in most
cases this will be every page of your site).

This helps SmartEngage find accurate information on your customers.

That's it! 

You've now integrated the SmartEngage tracking code to your website. It’s time to test that it's
working

View Page Source
Visit your website with Google Chrome browser and right click anywhere on your page. Select the
drop down that says "View Page Source"

Find Your Tracking Code

https://smartengage.com/knowledge-base/books/faq/page/where-can-i-find-my-brand-avatars-tracking-code
https://smartengage.com/knowledge-base/books/faq/page/where-can-i-find-my-brand-avatars-tracking-code


Next, you will need to find the SmartEngage Tracker in the code. A quick way to search for this is to
press Command-F on mac or Control-F on windows which will bring up a search bar.

In the search bar, you will type "smartengage" If you have it installed on your page, you will see
code similar to this:
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If that search doesn't bring up the SmartEngage tracking code, you will need to go back into Step
1: Installing your SmartEngage tracking code and follow the instructions.

Duplicates
Make sure that you only see one instance of the SmartEngage script in the code. If you notice that
the SmartEngage snippet of code is installed twice on the page, you will want to go into your code
to remove one of them, otherwise it won't trigger properly.

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/XEVimage.png


How Do I Add TXT Records
for SPF and DKIM?
Check out Our Guide for adding SPF and DKIM by This Provider list :

https://smartengage.com/knowledge-base/books/adding-dns-records-for-spf-dkim 

DomainKey Identified Mail (DKIM) and Sender Policy Framework (SPF) are two methods that can
protect you from email spamming, spoofing, and phishing attempts.

The SPF method lets you specify which email servers are legitimate servers for your
domain.
The DKIM method lets you attach a DomainKey signature to your outgoing mail. The
receiving server then verifies the validity of the key and either accepts or rejects the mail.

SPF and DKIM are frequently used in combination since they attack email problems from two
different angles.

At SmartEngage we want you to have the best email deliverablity possible so we
require you to add 2 TXT records in your DNS settings of your hosting provider.

 

Step 1: If you are in the process of creating your brand avatar you can skip to Step 2 where we list
the records.
Otherwise, if you initially skipped this step during Brand Avatar Creation please visit your main
dashboard page click on your brand avatar to reveal the link for "Manage/Integrate
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Step 2: After clicking Manage/Integrate you will scroll to the very bottom of the page in order to
see the section with your brand avatar's custom records.

It will look something like this:
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https://smartengage.com/knowledge-base/books/adding-dns-records-for-spf-dkim
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Step 3: Log into your hosting provider or contact them and give them the records from following
the steps above and ask them to add 2 TXT records with that information.

If you would like to do this yourself it can be done very easily. Here's an example demonstration
video below.

NOTE: If required to provide an actual number for TTL, plese enter 14400

https://player.vimeo.com/video/276988332

Please use the link below to view instructions for various hosting providers

Please note that you want ONLY 1 SPF Record to exist in your DNS settings.

If you have an existing SPF record already that you need to keep then you will have to merge the
records into one single record. For assistance with this please open a support ticket.

https://player.vimeo.com/video/276988332


Where is SmartEngage
Hosted?
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Amazon Web Services (AWS) is a highly reputable and widely used cloud computing platform that
provides a range of services and tools for businesses and organizations to build, deploy, and
manage applications and infrastructure in a flexible and scalable manner. SmartEngage's decision
to host its services on AWS reflects a commitment to delivering high-quality, reliable, and scalable
solutions to its customers. Here's a more detailed explanation of why AWS is known for its high
quality:

1. Global Reach: AWS operates data centers in multiple regions around the world, allowing
SmartEngage to offer its services to customers globally. This global reach ensures low-
latency access and high availability, enabling SmartEngage to serve its customers
effectively, regardless of their geographical location.

2. Scalability: AWS provides on-demand scalability, which is crucial for a service like
SmartEngage. It allows SmartEngage to handle varying workloads and traffic spikes
without investing in and managing a complex infrastructure. This scalability ensures that
SmartEngage can grow and adapt to its customers' needs seamlessly.

3. Reliability: AWS offers a high level of reliability through its redundant data centers,
backup systems, and disaster recovery capabilities. SmartEngage can leverage these
features to ensure that its services are available to customers 24/7, with minimal
downtime.

4. Security: AWS places a strong emphasis on security, providing tools and features to help
organizations protect their data and applications. SmartEngage can benefit from AWS's
security features to safeguard customer data and ensure compliance with data protection
regulations.

5. Cost Efficiency: AWS's pay-as-you-go pricing model allows SmartEngage to optimize its
costs by only paying for the resources it consumes. This flexibility helps SmartEngage
manage its budget effectively while offering competitive pricing to its customers.

6. Ecosystem and Integration: AWS offers a vast ecosystem of services that can be
seamlessly integrated into SmartEngage's platform. This allows SmartEngage to leverage
a wide range of tools and services, from databases to machine learning, to enhance its
offerings and meet customer needs.

7. Managed Services: AWS provides managed services that offload operational tasks, such
as server maintenance and database management. This allows SmartEngage's team to
focus on developing and improving its product rather than managing infrastructure.



8. Compliance: AWS maintains a strong focus on compliance and certifications, which is
essential for businesses in regulated industries. SmartEngage can rely on AWS's
compliance programs to meet industry-specific requirements.

In conclusion, hosting SmartEngage on AWS demonstrates a commitment to delivering high-
quality, reliable, and scalable services to its customers. AWS's global infrastructure, scalability,
security, reliability, and extensive service offerings provide SmartEngage with the tools and
resources needed to deliver a top-notch experience to its users, making it a wise choice for hosting
and scaling a sophisticated engagement platform.



How Do I Add Team
Members to Manage My
Account?
Adding team members is a great way to have an assistant or someone you trust help manage your
Brand Avatar.  Permissions must be given for each Brand Avatar individually.

NOTE: The ability to add Team Members to your account is reserved for BASIC plan or higher plans
to SmartEngage

Step 1: Click on Manage / Integrate for the Brand Avatar you wish to provide access.
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Step 2: Click the left navigation menu for "Members"
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Step 3: Enter the email address of the person you wish to add as a new member of this Brand
Avatar. You can them as an "Admin" or "Contributor".
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Admin - Has full access to everything related to this Brand Avatar

 

Contributor - Has limited access related to this Brand Avatar

Account contributors can create and edit campaigns, broadcasts, and automation rules, but they do
not have access to these account settings:
• Members

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/Vplimage.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/ewNimage.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/FJMimage.png


• Billing
• Integrations

After you click the button for "Send Invitation" that person will receive an email with an invitation
to manage your brand avatar. 

Once they follow the steps to join they will automatically have permission to manage your Brand
Avatar page according to the permission level assigned by you.

You can set further permissions by clicking the gear icon next to their role status and set
permissions for:

a. Exporting Subscribers

b. Running Bulk Operations on the Subscribers Page

c. Sending Broadcasts
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Why is my Facebook
Messenger Chatbot not
working?
Facebook Messenger platform can unexpectedly drop page permissions on admin password change
or due to its internal reasons. In case of any trouble with content sending or service setup, we
recommend you refresh permissions.

In order to do that please use the following steps:

Step 1: From your logged in Dashboard page click on your current Brand Avatar and then directly
underneath it click on "Manage/Integrate".
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Step 2: On the left navigation menu click on "Facebook Permissions"
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Step 3: We have two options here. 
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Refresh Permissions: This is the second option on this page. This option usually corrects most
chat bot issues and should be used as your first method to fix the issue you are having.

Reconnect Facebook Account: This is the first option on this page. This option should be used
after attempting to refresh permissions and you are still having issues.

Your page permissions will be reset and should start working now. If you still run into issues after
completing the above steps please submit a support ticket.
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Confirm SmartEngage is
configured as your primary
receiver
Step 1: Visit the Settings page of your Facebook page and click on "Messenger Platform" from the
left navigation menu.
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Step 2: Click under the "Connected Apps" section and you should see SmartEngage listed.  Click
on the "Configure" button

Step 3: You'll be presented with a popup window like the one below. Simply ensure that the
Primary Receiver has SmartEngage selected in the dropdown selector. 
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Confirm two-factor Authentication is set
up
If the aforementioned steps didn't help, please check whether you have two-factor authentication
set up for the Facebook page connected to your Avatar on SmartEngage.

Make sure to set up two-factor authentication for your Facebook profile following the 
instructions here. When two-factor authentication is enabled both for your profile and for the
specific page, this page should function properly. 

If nothing mentioned above helped, please contact our support.
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Why Web Push Notification
Delivery Rate Might Be
Lower Than Expected
It is perfectly normal and expected that you will have less than 100% sent for your web push
notifications.

Why?

Web Push Notifications resonate with the quick and real-time distribution of brand name
interactions. Usually, there are circumstances where not all customers obtain the alerts you send
out or schedule for sending out.

Here are the reasons that your delivery rate might be under 100%.

1) The internet browser is closed on the device
Web Notifications appear on a customer's display (on both desktops and also mobile web browsers)
when the web browser is open. This indicates that even if your subscriber is surfing various other
sites, they will certainly obtain your notifications. But, if the internet browser itself is closed, they
will only obtain your notice when they reopen it.

2) Users clear other website data in Chrome
When customers clear various other website data from Chrome, the service workers are
uninstalled. With this, your website will not have the ability to send out notifications to that
particular subscriber, resulting in a lower delivery rate.

3) The customer disables background Application activity
People are able to switch off background refresh for apps. One factor could be to conserve the
mobile battery usage. As well as this can additionally forcefully disable the Chrome or Firefox
Application. 

4) Network troubles break the connection between GCM and the user
Many times, users are not connected to the internet for a very long time. The factors could be
several, from remaining in locations without network protection to staying clear of roaming fees.
When this happens, the tool sends heartbeats at a period of 28 minutes on the mobile phone
network and also 15 minutes on WiFi (GCM's idle socket connects an Android device to the Google
servers).

https://developer.mozilla.org/en-US/docs/Web/API/Service_Worker_API
https://developers.google.com/cloud-messaging/


If this heart beat does not reach the GCM web server, Google continues to re-attempt the
connection. If the press notification individual is disconnected from the internet for a lengthy
duration, GCM can neither provide the notices nor mark them as inactive. This can either postpone
the distribution of the notifications or not supply them entirely.

5) Browser App uninstalled
When a customer uninstalls an internet browser application, there's a delay in GCM tagging that
device as non-functioning. This results in the alert being sent out to the GCM, GCM attempting to
send it to the gadget, as well as failing at it.



How to Unarchive a tag
Should you decide you want to place a previously archived tag back into active status simply follow
these steps.

1. Click on your brand avatar and then select "Manage / Integrate"
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2. On the left side of the navigation menu click on "Tag Manager"
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3. Scroll to the bottom and find the section labeled "Archived"

4. Click the icon as per the below image and that tag will be made active once again.

image.pngImage not found or type unknown

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/Yf3image.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/0Hbimage.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/31nimage.png


What are Unsent messages?
You may have noticed that when viewing your report page for sent engagements that there is a
sub-section labeled "Unsent".
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Unsent messages are typically reported when emails are sent to those email addresses which may
have a full mailbox (soft bounce) or an unavailable mailbox (hard bounce).

In the case of the former, the email is not able to be sent at this particular time, but the user is not
unsubscribed from your list.

In the case of the latter, the email is not able to be sent due to a permanent issue so the user is
automatically unsubscribed in order to keep your sending domain in good standing for future
sends.
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Why isn't Customer Chat
Lead Magnet visible on
website?
There might be several reasons to why you don't see your widget:

1. Incorrect visibility settings;
2. Problem with Facebook SDK code or another customer chat app;
3. Widget code installed incorrectly;
4. Website CSS styles hides the widget.

1. Head to the Lead Magnet's 'Setup' tab and check 'Visibility Settings' section:

If you entered something here, delete everything and test if the widget appears at all. If it does -
problem solved; you will only need to set up correct visibility settings then according to your needs.
If it doesn't - head to the paragraph below.

2. Check the Developer Console on your website (F12 in Google Chrome or mouse right-click =>
Inspect Code)

You might see the following error message:

"The CustomerChat plugin is no longer part of the main Facebook SDK.
# To continue using it please use the correct SDK URL,
# meaning replace sdk.js with sdk/xfbml.customerchat.js.
# For more details see https://developers.facebook.com/docs/messenger-
platform/discovery/customer-chat-plugin/sdk/"
If you do have this error message, all you have to do is replace "sdk.js" with
"sdk/xfbml.customerchat.js" in your site's code. If the error persists, simply delete all the code
associated with Facebook SDK.

If you had any other Customer Chat widgets installed along with SmartEngage, choose only one
widget and delete the code of every other widget.

3. Ensure your SmartEngage universal avatar tracking code is installed in the <header>



Adding an Admin to Your
Facebook Fan Page
Step 1: Go to your Facebook fan page

A list of all the pages you manage can be found at this link: 
https://www.facebook.com/bookmarks/pages

Step 2: Click Settings

Once Facebook directs you to your fan page, click “Settings” located on the right side of your
screen above your Facebook cover image.

image.pngImage not found or type unknown

Step 3: Click “Page Roles”

Click “Page Roles” on the left side of your screen under the section “General“.
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Step 4: Add an admin

To add an administrator, type the name or email of the person you want. Here, you can assign
different roles to different people. For example the purpose of what is necessary here we will select
Admin

After assigning roles, click “Save“.
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Step 5: Re-enter password

For safety purposes re-enter your password. Click “Submit“.
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Step 6: You’re done!

The people with roles you’ve assigned will appear on your Page Roles page under the "Existing
Page Roles" section such as this:
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Do you have any Pre-made
Chatbot Templates?
Certainly! Here's a description for your question:

Yes, we offer a selection of pre-made chatbot templates designed to streamline your automation
efforts. These templates cover a range of use cases and industries, providing you with a head start
in creating efficient and engaging chatbots for your specific needs. Explore our library of templates
and kickstart your chatbot journey with ease! here it is the list of pre-made chatbot templates for
business :

Food Truck
Dentist
Car Dealer
Photographer
Realtor
Coffee Shop
Accountant
Kickboxing
Chiropractor
Nail Salon
Yoga Studio
5 Star Review Follow up
Birthday Bowling Bot
Book Author
Wedding Photographer
Fitness Club
Instagram FAQ
Local Business General
Ballroom Dancing
Pool Service
Home Improvement
Fishing Charter
Pressure Washing
Counseling Service
Dry Cleaners
Wedding Venue
Music Studio
Nanny Service
Dumpster Drop Off Service



Electrician

See a template you want?  Just contact us at support@smartengage.com and give the
details as below :

1. Avatar Name

2. The names of the Template(s) you'd like added to your account.

mailto:support@smartengage.com


How Do I Add Team
Members to Manage My
Account?
Adding team members is a great way to have an assistant or someone you trust help manage your
Brand Avatar.  Permissions must be given for each Brand Avatar individually.

NOTE: The ability to add Team Members to your account is reserved for BASIC plan or higher plans
to SmartEngage

Step 1: Click on Manage / Integrate for the Brand Avatar you wish to provide access.
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Step 2: Click the left navigation menu for "Members"
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Step 3: Enter the email address of the person you wish to add as a new member of this Brand
Avatar. You can them as an "Admin" or "Contributor".
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Admin - Has full access to everything related to this Brand Avatar

 

Contributor - Has limited access related to this Brand Avatar

Account contributors can create and edit campaigns, broadcasts, and automation rules, but they do
not have access to these account settings:
• Members
• Billing
• Integrations

After you click the button for "Send Invitation" that person will receive an email with an invitation
to manage your brand avatar. 

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/Hbmimage.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/Ofuimage.png
https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/r9Ximage.png


Once they follow the steps to join they will automatically have permission to manage your Brand
Avatar page according to the permission level assigned by you.

You can set further permissions by clicking the gear icon next to their role status and set
permissions for:

a. Exporting Subscribers

b. Running Bulk Operations on the Subscribers Page

c. Sending Broadcasts
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How to Disable Notifications
From Facebook Page?
1.  In the very top right of your Facebook, click the little dropdown arrow, then click on the name of
the page you wish to stop receiving notifications for. If you don’t see the page, click “see more”
and select it from the list.

2. You are now at your page. Click the “Settings” link from the top right of the page.

3. On the left, click “Notifications”.

4. Select “Off” for any notifications you no longer wish to receive. You can also manually disable
specific types of notifications by clicking “Turn Off” beside it.

Note that you’ll need to do this for each page that sends you notifications.



Creating / Managing Tags
There are many areas of the site where you can add new tags, but here is the main way to manage
your existing tags.

Step 1: Click on your Brand Avatar in the top left and then click on Manage / Integrate
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Step 2: On the left navigation menu click on "Tag Manager"
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Step 3: Click on Create New Tag
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Step 4: Enter new tag and click Create
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Missing Images in an Email
Client
Enable missing images to display in various email clients
Sometimes images don't display for various reasons. If your contacts are telling you that they
received you email but content isn't displaying properly, you can start by having them check on
their email settings.

AOL Webmail
Display images for individual emails

1. Open the email with blocked images.
2. In the "Images Blocked" banner at the top of the message, click Don't Block This

Sender.

Display images for individual senders

1. Open an email from a specific sender
2. In the "Images Blocked" banner at the top of the message, click Don't Block This

Sender.

Disable image blocking for all messages

1. On the upper right-hand corner of your screen, click Options > Mail Settings.
2. Click General.
3. Under the Reading section, deselect the Hide images in mail from unknown senders

 option. 

For further assistance, please see AOL Support

 

Apple Mail
Display images automatically within your inbox

1. Click Mail > Preferences.

https://help.aol.com/contact


2. Click the Viewing button.
3. Make sure Load remote content in messages is checked
4. Close the window.

For further assistance, please see Apple Support

 

Earthlink Web Mail
Display images for individual emails

1. Open the email with blocked images.
2. Click the View Images link at the bottom of the email to show all the images in that

email.

Display images in all emails

1. Click Preferences.
2. Click the Message Display tab.
3. Click Image Display.
4. Select Show Images.

For furhter assistance, please see Earthlink Support

 

Entourage
Display images for individual emails

1. Open the email.
2. Click Download Images at the top of the email.

Display images from contacts that are in your address book

1. Click Entourage. 
2. Click Preferences. 
3. Click Security.
4. Click Automatically Download.

Entourage was replaced with Outlook. For further assistance, please see Microsoft Support

 

https://support.apple.com/mail
https://support.earthlink.net/articles/email/earthlink-e-mail.php
https://support.office.com/en-us/outlook


Gmail

Gmail should automatically display images by serving them through
their own secure proxy servers. If images are not displaying
automatically, you can manually adjust your settings.
Display images in Gmail

1. Click the gear icon on the top right corner of the page.
2. Select Settings.
3. On the General tab, Click the Always display external images radio button.
4. Scroll to the bottom of the page and click Save Changes.

For further assistance, please see Gmail Support

 

iPhone/iPod/iPad

If the mail application can't download an email properly, try to reopen
the message.
As the app limits the amount of content, sometimes they won't
automatically download the whole content of the email.
View the content of a large email

1. Scroll to the bottom of the message.
2. Click the Download Full Message button.

Display images for individual emails

1. Click My Settings icon.
2. Under Settings on the left, select Mail, Contacts, Calenders.
3. On the right-hand side, under Mail, find the Load Remote Images option.
4. Slide the bar to ON.

For further assistance with iOS devices, please see Apple Support

 

Lotus Notes
Display images in Standard Notes

https://support.google.com/mail/?hl=en#topic=7065107
https://support.apple.com/mail


1. Click File > Preferences (Note: Mac OS X users Click Lotus Notes > Preferences).
2. Click the plus sign beside Mail.
3. Click Internet.
4. Clear the checkbox for "To ensure privacy, do not show remote images without my

permision" option.

Display images in Basic Notes

1. Click File.
2. Click > Preference.
3. Click > User Preferences (Note: Mac OS X users Click Lotus Notes > Preferences).
4. Click Mail.
5. Click Internet.
6. Clear the checkbox for "To ensure privacy, do not show remote images without my

permission" option.

For further assistance, please see IBM Support

 

Outlook (formerly Hotmail/Windows Live)
Display images for individual emails

1. Open the mail.
2. Click Show Content at the top of the email.
3. Click Show blocked content.

Disable image blocking for all messages

1. Click Settings.
2. Click View all Outlook settings.
3. Click Mail > Layout.
4. Under Sender image section, select Show sender images.

For further assistance, please see Microsoft Support

Outlook 2003
Display images for individual emails

1. Open the mail.
2. Right-click on one of the missing images.
3. Select Download Pictures.

https://www.ibm.com/mysupport/s/?language=en_US
https://support.office.com/en-us/outlook


Disable image blocking

1. On Tools, Click Options.
2. Click Security.
3. Under Download Pictures, click Change Automatic Download Settings.
4. Uncheck "Don't download pictures or other content automatically in HTML email"

For further assistance, please see Microsoft Support

Outlook 2007
Display images for individual emails

1. Click Tools.
2. Select Trust Center.
3. Select Automatic Download.
4. Uncheck "Don't download pictures automatically in HTML e-mail messages or RSS items"
5. Click OK.

You can also add the sender's contact in your safe sender list to
ensure the images from the certain sender can be automatically
downloaded. 
Add a contact to your safe sender list

1. Click Tools > Option.
2. On the Preferences tab, Click the Junk E-mail button.
3. Click the tab for Safe Senders.
4. Click Add to add the email to the list.
5. Click OK to exit this window.
6. Click OK to close out of the Options menu.

For further assistance, please see Microsoft Support

 

Outlook 2010
Display images for all emails

1. Click the File > Options.
2. Click Trust Center.
3. Click Trust Center Settings button.

https://support.office.com/en-us/outlook
https://support.office.com/en-us/outlook


4. Uncheck "Don't download pictures automatically in HTML e-mail messages or RSS items"
option.

For further assistance, please see Microsoft Support

 

Outlook 2007, 2010 and 2013 - Secure Images

If you happen to be loyal to Internet Explorer, it has a security setting
that, when enabled, prevents Outlook to display images with a secure
URL (Image URLs with "http" will display, but not "https").
Change the setting in Internet Explorer

1. Open Internet Explorer.
2. Go to Tools > Internet Options.
3. Click the Advanced tab.
4. Scroll down to the Security Settings list, uncheck "Do not save encrypted pages to disk"

option.
5. Click OK.

Note: It may sometimes be necessary to clear the cache in Internet
Explorer and close Outlook (File > Exit to close fully). When it's done,
try sending yourself another email with an image that did not display
previously. 

For further assistance, please see Microsoft Support

 

Outlook 2016
Unblock picture downloads for all messages (if this doesn't resolve your issue, check if you have
text-only emails enabled)

1. Click File.
2. Click Options.
3. Click Trust Center.
4. Under Microsoft Outlook Trust Center, Click Trust Center Settings.
5. Uncheck "Don't download pictures automatically in HTML e-mail messages or RSS items"

Disable text-only emails

https://support.office.com/en-us/outlook
https://support.office.com/en-us/outlook


1. Click File.
2. Click Options.
3. Click Trust Center Settings.
4. Click E-mail Security.
5. Under Read as Plain Text, make sure "Read all standard mail in plain text" is

unchecked.

For further assistance, please see Microsoft Support

 

Outlook Express 6
Unblock images

1. Open Outlook Express 6.
2. On Tools, Click Options, then Click the Security tab.
3. Uncheck "Block images and other external content in the HTML email"
4. Click on Apply then click OK.

Unblock images using Internet Explorer

1. Go to Tools > Internet Options, Click Advanced tab.
2. Scroll down to the "Multimedia" section and check "Show Pictures"

For further assistance, please see Microsoft Support

 

Thunderbird

To protect your privacy, Thunderbird blocks remote images by
default. Thunderbird will display an alert saying that remote
images have been blocked.
View remote images

1. Click Show Images or Load Images that appears to the right of the alert message.

View images from all senders

1. Click Tools.
2. Click Options.
3. Click Privacy.

https://support.office.com/en-us/outlook
https://support.office.com/en-us/outlook


4. Click General and make the desired changes.

Enable remote images in Thunderbird 2.0

1. Open the email.
2. Click Click here to always load remote images from ... at the top of the email.

For further assistance, please see Mozilla Thunderbird Support

 

Yahoo
Display images for individual emails

1. Open the email.
2. In the "This message contains blocked images message, Click Show Images.

Disable email blocking for all messages

1. Click Settings > More Settings.
2. Click Viewing Email.
3. Under Show Images, select Always, except in spam folder.

For further assistance, please see Yahoo Support

If the settings in the email contact is as listed as above and your contact still can't view images:

Make sure your images are hosted on a public web server. If your images are stored on
your personal computer or if you need a password to access an image, it wont be
displayed.
Have your contact try opening your email in another web browser. If it's opened in
another, they can try unblocking images in the browser that isn't working.
Sometimes the image is just too large or in a format that the email client doesn't support.
Most common formats are: JPG, PNG and GIF.

https://support.mozilla.org/en-US/products/thunderbird
https://en-global.help.yahoo.com/kb/new-mail-for-desktop


How do I change my time
zone?
SmartEngage uses Time zones at the Avatar level. This way you can adjust this setting based on
the specific needs of the individual business/persona.

Step 1: Click on your Brand Avatar in the top left and then click on Manage / Integrate
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Step 2: Scroll down the page near the bottom and you will see the section for "Avatar Timezone"

Step 3: Simply click on the dropdown and select the time zone you'd like for this avatar.
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Step 4: Click Save Changes
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Why do I need my own
domain to send email?
Have You Ever Asked Yourself
"Why do I need my own domain to send email? Can't I just use my
@gmail address?"
All marketing emails should be sent from a domain you own, not from a personal
account at a provider domain, like @gmail, @hotmail, @yahoo, etc. or in an ISP email in some
cases.

In almost all cases we've seen, those addresses can all issue a block whenever bulk email is sent
from their domain. This is because the most important factor in email deliverability is
domain reputation, and when you send mail from a Gmail account, you're actually using Gmail's
reputation, not your own.

NOTE: Even if your provider does not currently block email, it is very likely that all email providers
will do so in the near future. The best way forward is to create an email address at a domain that
you own, so you can start building up your own domain reputation!

Think of it this way
When you send something in the mail, a carrier (UPS, DHL, Post Office) transports it for you. But it's
still coming from you, the carrier isn't just going to pick it up off the street (hopefully), and the
recipient is more likely to accept a letter coming from someone they know.

Email is much the same. SmartEngage is the carrier, but it also depends on your sending
reputation, and the domain email is how you build that trust.

Here's how to get started!
There are normally three ways to add email to your domain and start
sending emails with that address.
1. Where you bought your domain
Almost all domain providers will be able to provide you with an option to add email to your
purchase. Then you'll have the name@domain.com address you need, and even if you don't set up
the Inbox entirely you can still set up forwarding to your normal Gmail or Yahoo address. Examples
are sites like Google Domains, Namecheap, and Hover.



2. Where you host your website
Many people buy their domain the same place they host their website. BlueHost, HostGator, and
GoDaddy all offer both domains and hosting so they are popular all-in-one options. Squarespace
and Wix make it easy to add email to your account with options in your dashboard.

NOTE: For either option, the best way to find out how to do this is simply Google "website host and
email account", with your host/provider in the search bar.

3. Google Suite
Did you know you can still use Gmail with your domain email? It's true! You can use G Suite to
manage your domain email address, plus Google Docs, Sheets, and more! Click here to sign up and
get started, plans begin at $5/month.

https://gsuite.google.com/
https://gsuite.google.com/


Do You Have an Affiliate
Program?
Yes. It is coming soon.



SmartEngage Email Whitelist
Instructions
Your providers do the best they can to keep spam out, but sometimes the systems they use
mistakenly catch good mail along with it.

So- We ask that you add us to your trusted list of senders, contacts or address book. All also known
as "Whitelisting."

If you do not see an email from SmartEngage in your Inbox, my email may have mistakenly been
sent to your spam folder.

Please open your spam folder and if you find an email from SmartEngage open it and mark it
as "Not spam"...

NEXT: Click on the providers or software you use to see how to make sure you get the mail from 
support@smartengage.com you have asked for.

Popular Apps
Gmail
Gmail App
Gmail Tabs
Yahoo
iPhone Mail
Outlook App
Outlook
Inbox by Gmail

Email Clients

https://help.smartengage.com/help/smartengage-email-whitelist-instructions#gmail
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#gmailapp
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#gmailtabs
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#yahoo
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#iphoneapp
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#outlookapp
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#outlook
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#gmailinbox


Outlook.com
AOL Web Mail
Comcast
EarthLink
AT&T
Thunderbird

Security Software
Norton
McAfee
Trend Micro

Spam Filters
Cloudmark
SaneBox
Barracuda Net
SpamAssassin
Top Spam Filters

 

Is your email client or spam filter not listed?

If SmartEngage is being filtered, try adding support@smartengage.comto your Address Book
or Contact list.

If messages continue to be sent to your junk folder contact your ISP or spam filter application
support and ask how to whitelist support@smartengage.com

https://help.smartengage.com/help/smartengage-email-whitelist-instructions#outlookdotcom
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#aol
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#comcast
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#earthlink
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#att
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#thunderbird
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#norton
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#mcafee
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#trend-micro
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#cloudmark
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#sanebox
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#barracuda
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#spamassassin
https://help.smartengage.com/help/smartengage-email-whitelist-instructions#top-spam-filters
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Gmail
To make sure our email gets delivered to your Inbox, you must add SmartEngage to your contacts
list.

 

If you do not readily find an email from SmartEngage...

Please check your Gmail Spam Folder:

1. - If you see the email from SmartEngage: Open the Email.
2. - Click the button on the toolbar, labeled Not spam

Next please, add SmartEngage to your Contacts list:

 

(2 minutes ago)
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  Reply

  Forward

  Filter messages like these

  Print

  Add SmartEngage to Contacts list  

  Delete this message

1. - Open the email from SmartEngage.
2. - Click the drop down arrow next to "Reply" in the upper right side the email from header.
3. - Click the "Add SmartEngage to Contacts List" from the list that appears.
4. - If SmartEngage does not appear in the dropdown list? Then you probably have already

added SmartEngage to Contacts.
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Gmail Mobile App
- If you are using the Gmail Mobile App on your mobile device, please open the app now.

 

If you are using Gmail Tabs such as "Promotions" please open your Promotions tab in Gmail.

If you do not find an email from SmartEngage, please check the Spam Folder:

1. When you find the email from SmartEngage

2. Tap the 

Image not found or type unknown

 menu icon - top right.

3. Then select Move to.

Screenshot of the Gmail App dropdown menuImage not found or type unknown

1. Then select Primary from the list.

Screenshot of the Gmail app move to menuImage not found or type unknown
 

This way you will always see SmartEngage in your Primary Inbox tab...

NOTE: My Preferred Folder does not exist by default in Gmail. It is there as an example only
since custom folders must be created by the user.

image.pngImage not found or type unknown

Gmail Tabs
- If you are using Gmail Tabs such as 'Promotions' please open your Promotions tab in Gmail.

 

1. - If you find an email from SmartEngage in your Gmail Promotions tab:

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/HF5image.png


2. - Grab and drag my email to the Primary Inbox Tab.
3. - After doing so, you will receive an alert like the one below at the top of your

Gmail toolbar.

The conversation has been moved to "Primary"
Do this for future messages from support@smartengage.com? Yes

1. - Click Yes in the yellow alert box at Gmail.
2. - This way you will always see SmartEngage in your Primary Inbox tab...

image.pngImage not found or type unknown

Yahoo! Mail
If you have not received an email from SmartEngage...

Check your Spam Folder. If you see an email from SmartEngage:

1. - Please open the email.
2. - Next click the Not Spam button on the top toolbar.

To ensure delivery: Create a filter to automatically send email from SmartEngage to your Inbox.

1. - Move your mouse over or tap the Gear icon in the top right navigation bar.
2. - Select Settings from the list that drops down.
3. - Choose Filters located on the left side of the page.
4. - Click the Add button on the Filters page.
5. - Create a name such as Whitelist in the Filter name field.
6. - In the From field leave the default contains selected.
7. - Enter our email address support@smartengage.com in the text box next to 

Contains...
8. - Choose the destination folder to which you would like the message delivered. For

example: Inbox.
9. - Click or tap Save...

10. - You will see in the next screen -Deliver to Inbox if From contains SmartEngage-
11. - Click or tap Save on this screen.
12. - You will be returned to your Yahoo! Inbox.

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/oDnimage.png
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- You may also move SmartEngage to any folder of your choice.

Image not found or type unknown

 

Outlook.com
Previously "Hotmail", "Live", "Windows Live" and "MSN"...

In the new Outlook.com you must click the Wait it's safe link if you find emails incorrectly
identified as spam.

Entering the email contact in the address book or contacts no longer whitelists the sender.

To ensure messages from specific email addresses are not sent to your Junk Email folder, you can
do one of two things:

1. - Check the Junk folder. If you see the SmartEngage email in your Inbox
2. - Open the email from SmartEngage...
3. - Click the "Wait it's safe" link

Mark Sender as "Wait it's safe!

SmartEngage (support@smartengage.com)
To: you@outlook.com

Microsoft SmartScreen marked this message as junk and we'll delete it after ten days.
Wait, it's safe! | I'm not sure. Let me check

Manually Add to Safe List

https://kbcdn.smartengage.com/uploads/images/gallery/2023-10/Hibimage.png


1. - Click gear the icon on the top right.
2. - Select Options in the drop down list.
3. - On the Options page under Preventing junk email click Safe and blocked senders
4. - Click the link Safe senders on the next page.
5. - Enter the email address support@smartengage.com in the text box.
6. - Click Add to list
7. - SmartEngage will now be added to your list of Safe senders
8. - Emails added to your Safe senders will not be delivered by mistake to your Junk folder.

Image not found or type unknown

AOL Webmail
To make sure our email gets delivered to your AOL Inbox- Please complete these two steps...

If you find SmartEngage in your spam folder:

1. Right click the email.
2. Click "Not spam" in the resulting list.

Add support@smartengage.com to your Address Book:

1. - Open the email from SmartEngage
2. - Click the show details link next to SmartEngage in the From field.
3. - Move your mouse over or tap support@smartengage.com to show the menu.
4. - Click or tap Add contact in the menu displayed.
5. - Add SmartEngage to the name fields
6. - Click Add contact

Email from that Domain will now be delivered straight to your Inbox.

Image not found or type unknown



Comcast
Please log into your Xfinity account and select your Comcast webmail:

1. Should you find an email from SmartEngage in your spam folder:
2. Open the email.
3. Click the   No iconImage not found or type unknown Spam (not spam) icon on the top toolbar.

Next please, add SmartEngage to your address book:

1. - Please open the email from SmartEngage.
2. - Click on the button at the top left of the email that says:

support@smartengage.com

+ Add to Address Book

1. - That will open your edit contact screen.
2. - Then click Save and you're all done.

Image not found or type unknown

EarthLink
If you are not receiving email at EarthLink, there are two actions you can take.

1. - Check Suspect Email folder
2. - Add SmartEngage to your address book.

With EarthLink, if you have SpamBlocker turned on, suspect messages are automatically send to
your Suspect Email folder if the Domain is not in your address book.

Suspect Email Folder:



1. - While in the Suspect Email folder, if you see SmartEngage...
2. - Select the Move to Inbox and Add Contact option from the drop down menu.
3. - This will add support@smartengage.com to your Address Book for future email

delivery assurance.

Address Book Inclusion:

1. - Open the email.
2. - ClickAdd to Address Bookin the email header.
3. - Use theAddress Book Editorto verify the sender's contact details and clicksave.
4. - Fill in support@smartengage.com as the email address of the sender.
5. - Any mail sent with the same Domain (right of the @ sign) will now be delivered to your

Inbox.
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AT&T
AT&T no longer maintains their own inbox.

Instead you can find your AT&T emails at Att.Yahoo.com

Please follow the Yahoo instructions for whitelisting an ATT.net email address.

Click or Tap here, to scoll to the Yahoo instructions...

Image not found or type unknown

Mozilla Thunderbird
Please open your Thunderbird email client:

 

https://help.smartengage.com/help/smartengage-email-whitelist-instructions#yahoo


If an email from SmartEngage appears in your Junk Folder:

Please mark that message as Not Junk.

Next, please add SmartEngage to your Address Book:

1. - Click the Address Book button.
2. - Make sure the Personal Address Book is highlighted.
3. - Click the New Contact button.
4. - Under the Contact tab, copy and paste the "From" address, 

support@smartengage.com into the email text box.
5. - Click OK.

Security Software
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Norton AntiSpam
This problem may happen if support@smartengage.com is accidentally added to the Blocked
List.

To remove the support@smartengage.com from the Blocked List:

1. - Start your Norton product.
2. - Click Settings.
3. - Depending on your Norton product, do one of the following:

For Norton 360:

1. In the Settings window, under Detailed Settings, click AntiSpam.
2. On the Filter tab, next to Blocked List, click Configure.

For Norton Internet Security:



1. In the Settings window, on the Network tab, click Message Protection.
2. Under AntiSpam, next to Blocked List, click Configure.
3. - In the Blocked List window, select the item that you want to remove, and then click

Remove.
4. - Click Apply, and then click OK.
5. - If you do not find support@smartengage.com in the Blocked list, go to next step.

To add support@smartengage.com to the Allowed List:

1. - Start your Norton product.
2. - Click Settings.
3. - Depending on your Norton product, do one of the following:

For Norton 360:

In the Settings window, under Detailed Settings, click AntiSpam.
On the Filter tab, next to Allowed List, click Configure.

For Norton Internet Security:

1. In the Settings window, on the Network tab, click Message Protection.
2. Under AntiSpam, next to Allowed List, click Configure.
3. - In the Allowed List window, click Add.
4. - In the Add Email Address window, from the Address Type drop-down, select the address

type.
5. - Add support@smartengage.com, and then click OK.
6. - In the Allowed List window, click Apply, and then click OK.
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McAfee Products
While McAfee has removed spam protection in the latest Anti-Virus software- You may still have a
version that offers spam filtering.

1. In order to add SmartEngage to the friends whitelist, please open McAfee and
click on Web & Email Protection.



2. Then click on Anti-Spam

There you can see various settings. You can change the spam protection level, change filter
settings, etc.

Click on Friends list
- Please add support@smartengage.com to your "Friends List" to always allow emails
from SmartEngage.
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Trend Micro
If you received an email message that was incorrectly moved to the Spam Mail folder by the Anti-
Spam Toolbar you can prevent this from occurring in the future.

The Anti-Spam Toolbar detects spam by looking for certain keywords in the email's subject or body.
Occasionally, it may detect what you consider legitimate email as spam.

To prevent this from occurring you can do either of the following:

1. - Add the SmartEngage to the list of Approved Senders.
2. - Decrease the Spam Email Filter Strength.

Note: You can also select the email and click Not Spam to report it to Trend Micro. However, this
feature serves only as a reference to their spam database, and it may not have an effect on how
the toolbar detects spam.

Add the sender to the list of Approved Senders:

1. - Open Microsoft Outlook.
2. - Click the Spam Mail folder then select the legitimate email detected as spam.
3. - Click Approve Sender on the toolbar.
4. - Click Yes when the confirmation message appears.

Decrease the Spam Email Filter Strength:



1. - Open Microsoft Outlook.
2. - Click Trend Micro Anti-Spam then click Settings.
3. - On the Spam Filter tab, move the slider bar to select a lower filter strength.
4. - Click OK to save your settings.

 

Spam Filters
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Cloudmark SpamNet
Cloudmark filters email based on content footprints. To assure our email has not been mis-
identified as spam:

 
1. - Select Cloudmark | Options... from the Cloudmark SpamNet toolbar in Outlook.
2. - Click Advanced.
3. - Go to the Whitelist tab.
4. - Click the Add button.
5. - Type: support@smartengage.com
6. - Click OK.
7. - Click OK.
8. - Click Yes.
9. - Click OK.
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SaneBox
Sanebox is not a filter, but a filtering system trained by you.

1. - Open your Webmail or Gmail where you use SaneBox.
2. - Open your @SaneLater folder.
3. - If you find an email from SmartEngage or an email from support@smartengage.com

 in @SaneLater...
4. - Please drag my email to your Inbox folder.
5. - By doing this you will always get our great content in your Inbox from now on!
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Spam Assassin
Spam Assassin is usually administered by your server admin. Please contact your admin and
request that he or she:

 
1. - Add the following entry to your user_prefs file, which is found in the .spamassassin

subdirectory on your web/mail server
2. - whitelist_from support@smartengage.com
3. - Save the user_prefs file or move the updated copy to your .spamassassin subdirectory.
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Barracuda Networks
Occasionally, Barracuda Spam Firewall will mark a legitimate message as spam. There are two
methods to whitelist email senders.

Whitelist Quarantined Senders:

1. - Open your email client. Barracuda should send you a summary each day listing
quarantined items. Choose the most recent Barracuda email message.

2. - Locate the email from SmartEngage and the sender email address 
support@smartengage.com that you do not want quarantined in the future. Click on
the word "Whitelist," which is in green print to the right of the email title. This will open
your list in a web browser.

3. - Click the box to the left of the email that you would like to whitelist. At the top of the
page, click "Whitelist." Barracuda will not block or quarantine the sender whose email
address appears on the whitelist.

Whitelist Senders and Domains:

1. - Open your web browser. Navigate to your company's Barracuda firewall homepage.
2. - Click on the Block/Accept tab.
3. - Choose "Sender Domain Block/Accept." Enter the Domain name from 

support@smartengage.com to whitelist. For example, you can enter aol.com to allow
all AOL addresses.

4. - You may enter a comment to remind you why you allowed this Domain. Click "Add."
5. - Click your mouse on the "Email Sender Block/Accept" tab. Enter the email address of an

individual sender that you want to whitelist, such as "support@smartengage.com"
6. - Include a comment. Click "Add." In the future, Barracuda will not block emails from this

sender.

Most Used Spam Filters

 



SPAMfighter
Highlight the email from SmartEngage with the email address support@smartengage.com to
Whitelist.

Click "More" in the SPAMfighter Toolbar and select "Whitelist".

Here you can choose if you want to Whitelist the email address support@smartengage.com or
the whole Domain.

To be sure that all emails from people in your Outlook contacts get through to you, you can import
and Whitelist them.

To do this, follow these steps:

1. - Click "More" in the SPAMfighter toolbar.
2. - Then "Options"
3. - Then "Filter settings"
4. - Then "Blacklists & Whitelists"
5. - Then "Whitelist email address"
6. - Then "Import".
7. - Select your 'Address Book' and click on "Check all"
8. - Click "Add"
9. - Click "Apply"

If you get a pop-up box offering you to upgrade to SPAMfighter Pro, it is because you have
exceeded the limit of 100 addresses. You can fix this by buying SPAMfighter Pro or by deleting
some of the addresses in your Black/White list. If you want to delete addresses, please go to:

1. - Click More" in the SPAMfighter toolbar.
2. - Then "Options"
3. - Then "Filter settings"
4. - Then "Blacklists & Whitelists"

 

Mail Washer



1. - Click Tools, then Blacklist & Friends.
2. - Click Add... on the right, the Friends list side.
3. - Make sure Plain email address is selected.
4. - Type: support@smartengage.com
5. - Click OK.
6. - Click OK.

ChoiceMail
1. - Open ChoiceMail
2. - Click on the Senders tab
3. - Choose "Approve another Sender"
4. - Type in the sender email address support@smartengage.com
5. - Click on OK

Spam Sleuth
1. - Select File, then Configure.
2. - Go to the Friends category.
3. - Make sure Active is checked.
4. - Type: support@smartengage.com on a line by itself in the entry field.
5. - Click OK.

SmartEngage is in no way associated with any of the brands, websites or applications quoted here.
All Trademarks ® are the property of their respective owners.


